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LABROS SOILVIEW-ANALYSIS FOR VARIOS

1. INTRODUCTION

Thank you for choosing the VARIOS automated measurement and evaluation system for
determining thermal conductivity of soil samples from METER Group.

This user manual covers the operation of the LABROS SoilView-Analysis software, used

to evaluate measurements obtained using the Transient Line Heat Source Method in the
VARIOS. Read the VARIOS User Manual along with this manual. Both are available on the
VARIOS support page (meter.ly/varios-support). Scientific background related to determining
thermal conductivity of soil samples is provided in both manuals.

LABROS SoilView-Analysis software is available for download also at the VARIOS support
page (https:/meter.ly/varios-support).

LABROS SoilView-Analysis is compatible with Microsoft® Windows® 10 or newer. The
software reads data recorded in VARIOS projects by the data acquisition software LABROS
SoilView and stored as *.varios files.

LABROS SoilView-Analysis performs the following operations:

« Applies required parameters for evaluating recorded experimental data such as column
length and tare weights of the measurement device components.

« Visualizes the raw data for thermal conductivity values and weight changes.

» Recalculates thermal conductivity values and net weight data to find volumetric
water content.

» Calculates and visualizes the data for thermal conductivity characteristics.

« Applies state-of-the-art thermal fitting models to the data, visualizes functions, and lists
of the values and confidence limits of the conductivity parameters.

« Exports graphs, raw data, calculated data, fitted functions, and other parameters of interest.

VARIOS combines a simple evaporation method with the measurement of thermal
conductivities via the single-needle probe. Actual volumetric water contents (VWC),

0 m*/ m?, are derived by continuously recording sample weights during the drying process
caused by evaporation. Thermal conductivity of the soil column, AWm™'K"!, is measured
via the single needle probe in high-temporal resolution. Therefore, VARIOS yields high-
resolution measurements of the VWC to thermal conductivity, A(0), relationship. The basic
principle and the scientific background of this combination is outlined in Markert et al. (2016).


https://meter.ly/varios-support
https://meter.ly/varios-support
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2. OPERATION

Please read all instructions in this section before operating the LABROS SoilView-Analysis
software to ensure it performs to its full potential.

2.1 INSTALLATION

Use the instructions in this section to install the LABROS SoilView-Analysis software on a
laptop or personal computer running Microsoft Windows 10 or newer operating system.

NOTE: The LABROS SoilView-Analysis software is only compatible with Microsoft Windows 10 or newer. It will not run
on a laptop running an iOS operating system (Mac).

1. Navigate to the METER VARIOS Support webpage (https:/meter.ly/varios-support).

2. Click on the LABROS SoilView and LABROS SoilView-Analysis software download link.
The LABROSSo1i1View_vx.x.x.exe file will be downloaded to the computer Downloads folder.

3. Doubleclick on the LABROSSoi1View_vx.x.x.exe file to start the installation.

NOTE: If there is a problem executing the LABROSSoi1View_vx.x.x.exe file, please download and install Microsoft
.NET Framework 4.8 manually and be sure to have the current version of the Windows installer.

4.  Click on the Next button in the lower-right corner of the LABROSSoi1View Setup window.

a. Toinstall both LABROS SoilView and LABROS SoilView-Analysis software click on
the Default button to use the default installation settings (Figure 1).

b. Toinstall only LABROS SoilView-Analysis do the following (Figure 1):
i.  Click on the Down Arrow next to the software that should NOT be installed.

ii. Selectthe Entire feature will be unavailable option from the dropdown list that
appears.

iii. Click on the Next button to start the installation.
This will keep the selected feature from being installed.

5. Follow the instructions in the installation wizard window until installation is complete.

#5 LABROS SoilView Setup - X
45 LABROS Soilview Setup - X

Custom Setup
Custom Setup

Select the way you want features to be installed.

Select the way you want features to be installed.

Click the i the tree below to ch thi featu il be installed.
! & icons in e tree below ange the way Teatures wil be instale Click the icons in the tree below to change the way features will be installed.

The complete package. =~ | LABROS Soilview Analysis 5.0.0|  The complete package
------ [E=H|LABROS Soilview 5.0.0
=3 Will be installed on local hard drive

=38 Entire feature will be installed on local hard drive

This feature requires 107MB on
wour hard drive.

Location: Cx\program Flles (x86) METER Group AG\LABROS Bromse... Location: C:\Program Files (x86) METER Group AGILABROS Brawise...
SoilView Soilview),

Defauic Disk Usage ack Conca Defaut Disk Lsage Back Cance

Figure 1 Custom Setup screens
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2.2 USER MODES

LABROS SoilView-Analysis software can be run in two different user modes affecting the
permissions to write or change parameters. The user mode indicater is depicted in the
bottom, right of the software window. The Public User is the default mode.

2.2.1 PUBLIC USER MODE

In Public User mode the software runs with default values applied to most specifications
(e.g., soil surface area or weight corrections).

To change the user mode select the appropriate mode from a drop-down menu located in the
lower right corner of the screen. A change of user status can be done at any time and from
any register tab (Information, Measurement, Evaluation, Fitting, or Export). The change will
be active immediately.

2.2.2 POWER USER MODE

Power User mode should only be used by experienced and skilled users who are trained in
soil physics and are familiar with the scientific background for data processing. Power User
mode allows the user to alter many of the default values or manipulate measurement data.

POWER USER MODE EXAMPLES

« Measurement data records that are obvious outliers can be edited or deleted, or undesired
records can be deleted at the beginning or end of a measurement campaign.

« Data that are measured on different devices (e.g., for experiments with different soil
column heights) can be processed.

IMPORTANT: Changed parameters will affect the results of the data processing and the implications on the
calculations must be known by the users (the software will not compensate automatically). The Power User mode is
available for those that know soil physics well. The Power User mode is not recommended for all other users.

2.3 STARTING THE PROGRAM

To start the LABROS SoilView-Analysis software do the following:
1. Openthe Windows Start menu.
2. Select LABROS SoilView-Analysis (or LABROS SoilView) from the list of programs.

On the first start of the software a welcome screen will appear. The welcome window
shows the LABROS software and file location, and two toolbar lines (Figure 2).

The first toolbar below the LABROS software and file location contains the File, Extra,
and Help drop-down menus.

The second toolbar contains icons for Show file explorer, Open, Save, Save as,
Feedback, Settings, and Manual.
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= LABROS SoilView-Analysis - [C:\Users\Alina\Desktop\Example_SAND_1.varios] - 5.0.0.0
File  Extra Help

® @@

Show file explorer Open Save  Saveas

— O X

Feedback | Settings = Manual

Figure2 Welcome screen

NOTE: The Feedback icon can be used for sending feature requests, bug reports, questions, or other comments.
Please be sure to enter a correct email address.

For more information about updates the user can do one of the following to view a PDF file:

« In the What is new in Version pop-up window that appears when software first starts

up, select the two arrow icon (>») at the end of each item to open a PDF with more detail
(Figure 3).

NOTE: If you select Don't show me this again when the What is new in version window pops up, this option will
no longer be available.

» Select the Help menu item on the first toolbar and then What is New from the
dropdown list.

[E oo somes

Fle Bwas Hep Log

@ @ @

What is new in Version 5.1

New Feature:

Running WP4C measurements using LABROS SoilView Software
Creating complete water retention curve more easily >>

Enptyscl | Sicone
sarlerig | et g
Baarce | “weigi ] wea b idweght ]

Senpe g

11/9R0P units 0 VARIOS unts: 0 Bilances: 0 Wp4c: 0

Figure 3 What is new pop-up window

If data sets were loaded in the previous session, LABROS SoilView-Analysis will
automatically load the data set last used. However, if the last exit from the software was not

regular (e.g., a crash caused by a corrupted data file), the software will open with an empty
screen and datasets will have to be reloaded.
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3. PROCESSING VARIOS PROJECTS

The information in this section describes the software menus and how to set up VARIOS
projects in the LABROS SoilView-Analysis software.

All commands follow the standard Windows operating system conventions used in Windows
graphical user interfaces (GUI).

The Show/Hide file explorer icon in the second toolbar line acts as a toggle that opens and
closes a file explorer window on the left side of the main window (Figure 4).

= LABROS SoilView-Analysis - [ChUsers\Alina\Desktop\Example_SAND_1.varios] - 5.0.0.0 — O X

File X www.metergrou

0 OO® @©®®

Save  Saveas Feedback @ Settings | Manual

Figure 4 Show/Hide toggle command

The Save icon opens a Save window enabling the user to name the file and choose where
the file will be saved. When command icons or entries are shown in gray they cannot be
used. For example, the Save icon can only be used if a project has been opened and modified
(Figure 5).

= LABROS SoilView-Analysis - [Ch\Users\Alina\Desktop\Example_SAND_1.varios] - 5.0.0.0
File Extra Help

| Hide file explorer

R,
Figure5 Save/Save as command

A list of additional available actions associated with the menu item or icon is indicated by a
triangle on the right side of the respective icon or entry (Figure 6).
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= LABROS SoilView-Analysis - [C:\Users\Alina',
File | Extra Help
=  Open Ctrl+0

Save Ctrl+5

By Saveas.
Import

1 G AExample_SAND_1.varios
2 M. \gepackte Probe T.varios
3 M\ \gepackte Probe 11.varios
4 MM\ A\Probe 1.1.varios

5 M\ \Probe 1.0.varios

6 M:\.\Probe 2.1.varios
7MM\\Probe 2.1 varios

8 M\ \Probe 2.0.varios

9 M:\..\gepackte Probe 1.varios
10 M. \gepackte Probe 1.varios
11 M\ \gepackte Probe 1varios
12 M. \gepackte Probe 2varios

M Close

Figure 6 List of additional command actions

Entries can sometimes be selected by key-combinations or shortcuts. If available the
combinations are indicated to the right of the respective entry.

To return to a previous menu or action press the ESC button.

Data from VARIOS project files (*.varios) can be processed in the LABROS
SoilView-Analysis software.

3.1 OPENING A PROJECT FILE

The File menu is used to open and save project files.

With an existing data file, follow the instructions below to open the project.

1. Select File from the toolbar menu (Figure 7).
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= LABROS SoilView-Analysis - [C:\Users\Alina\,
File | Extra Help

&=  Open Ctrl+O i
h
Save Ctrl+5S 1
By Saveas.
Import 3

1 G AExample_SAND_1varios
2 M:\..\gepackte Probe T.varios
3 M:\..\gepackte Probe 11.varios 1
4 M:\AProbe 1.1varios
5 M:\.\Probe 1.0varios
6 M:\..\Probe 2.1varios
7 M\ AProbe 2.1 varios
8 M:\.\Probe 2.0.varios
9 M:\..\gepackte Probe 1.varios L
10 M. \gepackte Probe 1.varios 1
11 M. \gepackte Probe 1.varios
12 Mi\..\gepackte Probe 2.varios

® Close

Figure 7 Select File menu

Select Open from the dropdown list (Figure 7).

The Open window will appear (Figure 8).

B Open
< v 4 B> ThisPC > Desktop
Qrganize « New folder
Name

# Quick access
|| Documents o+

¥ Downloads *

B Example_SAND_1
B Example_sAND_2

B Example_siLT
&=/ Pictures o+

== Google Drive (F:) #
[ Desktop
HYPROP 2 CAD file:
HYPROP 2 CAD file:
B Music

@ OneDrive
[ This PC

¥ Network

Date modified Type

3/30/2023 3:20 PM

LABROS SoilView ...
LABROS SoilView ...
LABROS SoilView ...

[J] Search Desktop
=~ M @
Size
1,110KB
1,110 KB
982 KB

File name: | Example_SAND_2

v| LABROS SoilView files(".bhdx;™.

Cancel

Figure 8 File > Open window
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3. Select the desired file by navigating in the Open window to the appropriate folder

(Figure 8).

Only files with LABROS SoilView-Analysis compatible extensions will show in the

Open window.

4. After opening a file a fourth line with three to five tabs will appear.

The tabs are titled Information, Measurements, Evaluation, Fitting, and Export

(Figure 9).

[i LABROS SoilView-Analysis - [ChUsers\Alina\Desktop\Example_SAND_1varios] - 5.0.0.0

File  Extra Help

Show file explorer = Open Save

General Information

Save as

| j| Information @_| Measurements E Evaluation i |F'll'tirlg a Export

Sample name:

Example_SAND_1

Start of measurement:
Stop of measurement:
Duration of Measurements: 12 Days

Geometric Parameters

14.01.2022 125124
27.01.202210:24:28

Sensor Unit Information

www.metergrou,

Feedback

Comection

Velume comection [ml]:
Weight comection [g]:

Measurement Profile

Type of sample fing; [250m ~ Serial number: 0314
Soil suface area [em2]: [50.0 Sensorunt name: VARIOS 314 Themal Conductivity Parameter: 5, 7W/m-1s-30-60-60
Soil column height [em]: |5.00 Device ID: 0 Heat Curve Fitting: nondinear

Soil volume [em3]: 250 Meedle ID: NS043
Fimware Version: 1,62
Device Parameters Scale Information
Empty soil sampling ring weight [g]: [193,0 Sefial number: 111222333
Sampling ring lid weight [al: (0.0 Scale name:  HYPROP Balance
O+ing (3x«) weight [g: |0.0
Needle weight [al: |28,7
Powerlser by |

- [m] >

Settings | Manual

Figure9 Open window

3.2 FILE MENU OPTION DEFINITIONS

The following subsections describe the File menu options and definitions.

3.2.1 FILE > OPEN

The File > Open option is the first entry in the File menu. Table 1 describes the type of data

file that can be opened.
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Table 1 Data File Type Description
File Type Descriptions

*.varios (default) A LABROS SoilView-Analysis version 5.0 (or higher) project file containing
information, measurement data, calculated thermal conductivity data, and fitted
function for a single measurement campaign.

NOTE: Measurement files are not backward compatible.

3.2.2 FILE > SAVE

The Save option is used to save a project file that has been imported or processed. All
changes will be saved in the folder under the name where it is already saved. If no changes
to an existing project have been made, the Save icon and Save menu entry will be gray to
indicate it is inactive.

3.2.3 FILE > SAVE AS

The Save as... option is used to save a file under a different name.

NOTE: A file can be opened and processed with LABROS SoilView during the data acquisition stage. However, this
original file is write-protected as long as the measurement campaign continues. If preferred the file can be saved with
a different name.

3.2.4 RECENTLY OPENED PROJECT FILES

The group of entries below Import in the File menu are recently opened projects. This allows
direct and quick access to these project files by selecting the project filename.

3.2.5 FILE > CLOSE

The Close option closes the data file. If changes have been made a message window asking
for confirmation to save changes will appear.

3.3 HELP MENU

The Help menu contains LABROS SoilView-Analysis information for the user. The following
subsections describe options provided in the Help menu (Figure 10).

= LABROS SoilView-Analysis - [Ch\UserstAlina Desktoph Example_SAMD_1.varios] - 5.0.0.0

File Extra | Help |
& Check for updates...
& User Manual
Hide file explo| @  Info..
o What is New 2R

Figure 10 Help menu
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3.3.1 CHECK FOR UPDATES

The Check for updates... option gives information about new available software versions and
provides a download link if necessary.

3.3.2 USER MANUAL

The User Manual option provides the current version of LABROS SoilView-Analysis User
Manual as a PDF document for viewing, printing, or downloading.

3.3.3 INFO...

The Info... option shows the LABROS SoilView-Analysis software version in use, lists the
VARIOS development team, and shows the disclaimer.

3.3.4 WHAT IS NEW

The What is New option shows a PDF file describing all new features and bug fixes that apply
to the current version of the LABROS SoilView-Analysis software.

10
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4. REGISTERS FOR PROCESSING DATA

The LABROS SoilView-Analysis software groups data processing in five registers (Figure 11)
for VARIOS dryout measurement, and VARIOS standalone:

« Information Register

* Measurements Register

« Evaluation Register (dryout measurement only)
« Fitting Register (dryout measurement only)

« Export Registers

Only three register groups in the LABROS SoilView-Analysis software are available for the
VARIOS standalone:

« Information Register

* Measurements Register

« Export Registers

The registers include all steps of the data evaluation process in a logical, consecutive
sequence. Normally the register tabs are used from left to right. Data processing options

can be specified and data can be edited or manipulated in all register tabs by selecting the
Power User mode.

| i Information ©_| Measurements ﬁ Evaluation i | Fitting a Export

Figure 11 Register groups

Uses, actions, and edits that are available in all registers:
« Values that can be edited are shown in an edit field.

« Values that cannot be modified are shown without the edit field.

« All variables that are expressed by numerical values are given with units (metric or imperial).
If a user edits a numerical value, the new value must be in the same unit.

» Whether or not a variable can be edited depends on which user mode is used.
Power Users can edit more fields than Public Users (Section 2.2).

» When inserting a numerical value, the proper decimal separator sign depends on the region
settings of the computer.

Default decimal separator for the German Operating System is the comma, and the default
decimal separator for the English Operating System is a period.

«» Fields for numerical values do not accept alphabetical letters or special characters.

If a user attempts to insert a character that is not permitted the field does not show the
typed character.

1
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« To save an input operation the cursor must leave the input field in one of the following ways:
* Press the keyboard Tab key
* Press the keyboard Enter/Return key

¢ Move the cursor with the mouse to another position in the window and left-click
the mouse.

In some menus an Accept button will appear and must be pressed.

« Hovering the cursor over an icon or register tab will show a pop-up with information
(Quickinfo) about the function for a few seconds.

« Context-sensitive menus can be activated by right-clicking the mouse while the cursor
hovers over some graphs and other content items.

4.1 INFORMATION REGISTER

This section describes how to use the Information register tab (Figure 12) to specify the
required parameters for the measurement.

[ LABROS SoilView-Analysis - \\MGMFS01\RedirectedF lina\D LABROS

ple_SAND_2.varics] - 5.0.0.0 - o x

www.metergroup.com

@®

Feedback | Settings = Manual

File Extra Help

Show file explorer | Open  Save  Saveas

G wemaon £5] Measremens [ Evaaton (5] g [ Bt

General Information Corection
Sample name: - [Ecample_SAND_2
Start of measurement:  14.01.2022 125141
Stop of measurement:  27.01.2022 12:45:39
Duration of Measurements: 12 Days

Volume comection [nll: [0 |

‘Wieight comection g]: 0,00

Sensor Linit Information Measuremert Profile

Serial number: 0314

Geometric Parameters
Type of samplering: [Z0m v

Soil urface area om2]: 50.0
Soil column height [em]: 500
Soil volume [em3]: 250

Device Parameters
Empty soil sampiing fing weicht [a): [152.2

Sampling ring id weight [g]: (0.0 |

Oing (3 weight lgh: (00|

Neede weigt [g]: 288

Sensor unitname:  VARIOS 314
Device ID: 0
Needle ID; NSO71
Fimware Version: 1,62

Themial Conductiviy Parameter. 5.7W/m-1s-30-60-60
Heat Curve Fiting: noniinear

Scale Information
‘Senial number: 111222333
Scale name:  HYPROP Balance

Nates

Description Value

General data

- Site coordinates

- Sampling date

- Site: description

- Soi type

- Land use

Soil physical deta

- Terture (‘clay, "sit, “sand)

- Soi texture class

- Sampling depth

- Organic carbon content

Sample preparation and han

- Infial saturation procedure

- Sweling handiing (suppres.

Figure 12

Information register

PublicUser
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The Information register is the first of five register tabs (Figure 12). When the Information
tab is selected it displays a window that contains eight blocks or subcategories (used for the
VARIOS dryout measurement), or four blocks (used for the VARIOS Standalone measurement)
providing an overview of the selected project. The four blocks used for the VARIOS
Standalone method are outlined in red (Figure 12).

4.2 DATA GROUPS

The following sections show examples of the different data groups accessed on the
Information register. Tables with definitions and editing options for each data group are
also provided below.

4.2.1 GENERAL INFORMATION

General Infamation
Sample name: | Example_SAND_1
Start of measurement:  14.01 2022 12:51:24
Stop of measuremenrt:  27.01.2022 10:24:28
Duration of Measurements: 12 Days

Figure 13 General Information

Table 2 Data Group General Information

Editable
Data Public Power
Variable Explanation Value User  User
The name can be chosen by the user. Sample Yes Yes
name
NOTE: By default the sample name is also used for the from
s l file name during export. The file name rules, specified LABROS
ample name by Windows, also have to be considered. If data was SoilView
captured from a VARIOS measurement campaign
with LABROS SoilView, the sample name specified in
LABROS SoilView is listed here.
Date and time from the start of the recorded - No No
Start of measurement data.These data are recorded in the *.varios
file automatically.
Date and time from the end of the recorded data. - No No
Stop of measurement  These data are recorded in the *.varios file
automatically.
Duration of Difference between start and end date of the - No No
recorded data calculated from the two fields
measurement

above and rounded to full days.

13
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4.2.1.1 CORRECTION DATA GROUP (DRYOUT MEASUREMENT ONLY)

Comection

Yolume comection [mi]:
Weight comection [a]: [0,00

(=]

Figure 14 Correction

Table 3 Data Group Correction

Editable
Data Public Power
Variable Explanation Value User User
Volume correct of the sample is possible and sometimes Ocm® Yes Yes
necessary when sample preparation has errors, deficits, or
Volume shows roughness.
correction  Correcting the volume will affect the water content
calculation because weight changes are related to the
sample volume.
Addition (positive) or subtraction (negative) of a constant 0g No Yes

weight to the tare weights, i.e., to the measuring head and
) the sample ring weight.
Weight
correction This could be the constant weight of a lid, a cable, or
another sensor that might be added in a measurement
campaign. In this case the additional weight value has to be
entered as a positive value for accurate weight correction.

4.2.1.2 GEOMETRIC PARAMETERS (DRYOUT MEASUREMENT ONLY)

Geometric Parameters

Type of sample ring: [230m w

Soil suface area [cmZ]: (50,0
Soil column height [cm]: |5.00
Soil valume [cm3]: 250

Figure 15 Geometric Parameters
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Table 4 Data Group Geometric Parameters
Editable

Data Public Power
Variable Explanation Value User User

The standard sample ring is the 250 mL ring 250ml  Yes Yes
(standard METER soil sample ring) with two

boreholes. If the user already chose the type of

sample ring used in the LABROS SoilView software,

the selected value is adopted in SoilView-Analysis.

A customized sample ring can also be chosen.
Type of sample ring Geometric parameters have to be adjusted.

Selecting a customized sample ring will affect the
subsequent default entries for surface area and height.

NOTE: The height ratio between the borehole for the needle
sensor and the bottom of the sample, as well as the distance
of the sensor to the sampling ring must be the same for the
METER standard sampling ring (250 ml).

Shows the surface area of the sample, dependent 50cm? No Yes

Soil Surface Area upon the chosen type of sample ring.

Height of soil sample. 5cm  No Yes

Default value is uses the height of METER standard
soil sample rings.

Soil Column Height . . .
Example: If swelling occurred during saturation and

the user decided not to cut the saturated sample to
exactly 5.0 cm, the Soil Column Height value has to
be adjusted.

Volume of soil sample is calculated from the entries  250cm® No No

Soil Volume of area and height.

4.2.2 SENSOR UNIT INFORMATION

Sensor Unit Information
Serial number: 0008

Sensorunit name: YARIOS_PRO0E
Device 1D: 0
MNeedle ID: 19

Fimware Version: 1.4

Figure 16 Sensor Unit Information
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NOTE: The information in these parameter groups are not affecting the calculations; values are given purely for

information purposes.

Table 5 Data Group Sensor Unit Information

Data
Variable Explanation Value

Serial number information for METER firmware provided -
through *.varios file.

Serial number NOTE: This number is always a unique identification of the

measurement device. Together with the date informationitis a
unique identifier of the measurement.

Information as specified in data acquisition and stored -

Sensorunitname ;. the x varios file.

. Information as specified in data acquisition and stored -
Devide ID . -
in the *.varios file.

Information as specified in data acquisition and stored -
Needle ID . -
in the *.varios file.

Firmware Version Information given by METER firmware. -

4.2.3 MEASUREMENT PROFILE
Measurement Profile

Themal Conductivity Parameter: 5W/m-1s-30-60-60

Heat Curve Fitting: nondinear

Figure 17 Measurement Profile
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Table 6 Data Group Measurement Profile

Editable
Data Public Power
Variable Explanation Value User User
Shows the measurement parameters - No No
defined in the VARIOS Profile
settings of the LABROS SoilView data
acquisition software.
Heating power
Thermal Conductivity Parameter .
Sampling interval
Number of drift samples
Number of heat samples
Number of cool samples
Shows the used fitting method - No No

defined in the LABROS SoilView data
acquisition software.

Nonlinear fitting assumes a nonlinear
heating over log(t) and linear heating
over log(t-t0). This is the recommended
fitting method.

Heat Curve Fitting

Linear fitting assumes a linear heating over
log(t). This fitting method is recommended
only for ASTM and |IEEE conformity.

NOTE: For more information about the parameters definition please refer to the Measurement Profile section in the
VARIOS User Manual (meter.ly/varios-support).

4.2.3.1 DEVICE PARAMETERS (DRYOUT MEASUREMENT ONLY)

Device Parameters
Empty soil sampling ring weight [al: {1930
Sampling ring lid weight [a]: |16.5
Q+ing (3x) weight [a]: |1.66
Needle weight [gl: (28,7

Figure 18 Device Parameters
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Table 7 Data Group Device Parameters
Editable

Data Public Power
Variable Explanation Value User User

Exact mass of the soil sampling ring (dry and clean). - Yes Yes

NOTE: This value must be specified individually for
each measurement!
Empty soil sampling

ring weight [g] The mass can be determined before or after the

VARIOS measurement. Wrong values transfer
linearly to wrong calculated total water contents.
An error of 2.5 g leads to a shift of calculated
water contents of 1%.

Exact mass of the sampling ring lid weight (dry - Yes Yes
and clean).

NOTE: This value must be specified individually for
each measurement!

Sample ring lid
weight [g]
The mass can be determined before or after the
VARIOS measurement. Wrong values transfer
linearly to wrong calculated total water contents.

Exact mass of the o-rings (dry and clean). - Yes Yes

NOTE: This value must be specified individually for
Silicone retaining each measurement!

ring weight [g] The mass can be determined before or after the

VARIOS measurement. Wrong values transfer
linearly to wrong calculated total water contents.

Exact mass of the needle sensor (dry and clean). - Yes Yes
NOTE: This value is individual for each needle sensor.

Needle weight [g] i
The mass of the needle sensor is stored and

automatically transferred from LABROS SoilView
data acquisition software.

4.2.4 SCALE INFORMATION (DRYOUT MEASUREMENT ONLY)

Scale Information
Seral number: 111222333

Scale name: HYFROP Balance

Figure 19 Scale Information
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Table 8 Data Group Scale Information

Variable Explanation

Serial number Information given by METER firmware through *.varios file.

Information as specified in data acquisition software and

Scale name stored in the *.varios file.

4.2.4.1 NOTES

Notes

Editable

Data Public Power
Value User User

- No No
- No No

Description Value

General data

- Site coordinates

- Sampling date

- Site description

- Soil type

- Land use

Soil physical data

- Texture (Wclay, Ysit, “sand)

- Soil texture class

- Sampling depth

- Organic carbon content

Sample preparation and han. ..

- Initial saturation procedurs

- Swelling handling (zuppres...

Figure 20 Notes data group
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Description

Value

Free Data Field
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Table 9 Data Group Notes

Explanation
Any information in tabular view.

Default value:

» General data

« Site coordinates
» Sampling date

« Site description
 Soil type

« Land use

Soil physical data:

« Texture (%clay, %silt, %sand)
« Soil texture class

» Sampling depth

« Organic carbon content

Sample preparation and handling:
« Initial saturation procedure
« Swelling handling (suppressed, not suppressed, under load)

Any information in tabular view.

Any informative text can be stored here that is related to
the measurement campaign.

4.3 MEASUREMENTS REGISTER

This section describes how to use the Measurements register tab (Figure 21) for
visualization and measured data editing.

The Measurements register tab (Figure 21) shows the readings of the needle sensor
and the recorded weights when data collection used the dryout measurement setup.

Editable

Data Public Power

Value User

- Yes

- Yes

- Yes

User

Yes

Yes

Yes

The register is composed of four windows for dryout measurement and two windows for
standalone measurement.

» The left windows show graphs of the recorded data.

« The right windows show the numerical values.

20
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Figure 21 Measurement register (dryout measurement setup)

The size of the data or graph windows can be resized in several ways:

« Place the mouse on a border (invisible) of an individual window and drag the border to a
new position.

« When the mouse is directly on a border it changes from a single arrow to a double arrow.
« Each of the graphics windows can be enlarged to full-screen by positioning the mouse

on the window, right-clicking the mouse button, and selecting the Maximize option in the
pop-up menu.

« To leave the full-screen mode press the Esc key.

« A user can (repeatedly) magnify portions of the graphs (even in Windows full-screen mode)
by placing the mouse on the graph and dragging the cursor to the opposite point of a
rectangle while holding down the left mouse button (Figure 22).

To reset the window ranges right-click the mouse button and select the Undo Zoom option.
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Figure 22 Conductivity graph

4.3.1 INTERPRETATION OF THE CONDUCTIVITY DATA

Figure 22 shows a continuous decrease of both thermal conductivity (top) and sample mass
(bottom) during the measurement campaign. This means a decrease in VWC is accompanied
by a decrease in thermal conductivity. In the beginning of the measurements the conductivity
data show a larger uncertainty (higher fluctuations), whereas at the end of the measurement
the curves are very smooth.

This phenomenon occurs because the heating power remained constant and the water
content was high in the beginning. Consequently, the thermal conductivity was also high in
the beginning. Therefore, the increase in temperature (DeltaT) due to the heating was low,
which leads to higher uncertainties in the slope of DeltaT(In(t)). This is reflected in higher
uncertainties in the resulting thermal conductivity. At the end of the measurement the
thermal conductivity is low leading to higher DeltaT. Higher DeltaT means lower uncertainties.
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4.3.2 DATAVISUALIZATION OPTIONS

| i Information |u| Measurements ﬁ Evaluation i | Fitting a Export

‘ | Show Data Points |

Figure 23 Data visualization options

In the toolbar above the graphs (Figure 23) the Show Data Points button is selectable on
the Measurement tab. This button activates and deactivates the depiction of the individual
measured data points as described in Section 4.3.3. This option is editable in both Public
and Power User modes.

4.3.3 CONDUCTIVITY GRAPH

The upper graph shows the thermal conductivity (Figure 24). The graph shows the data points
with one line. The x- and y-axes are automatically scaled to show all recorded data.

fevalo . Heating Temperat, ~

26| EEEiE KWK Power[W/n]  Dift[C]
2t 1401202125124 |25257 55316 6.8E05
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F 14012022 155124 |2.5488 55317 17505
204 14012022 165124 | 26063 55317 GEED5

F 4012022175124 |25717 55313 23605

= 18T 1401202185124 |25732 55313 45605
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< >

Figure 24 Upper graph

The temperature graph can be visualized by right-clicking the mouse and selecting the Show
temperature graph option from the pop-up menu (Figure 25).
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Figure 25 Pop-up dropdown menu

The temperature graph shows the changes of the thermal conductivity values as a line
without individual dots for the data by default (Figure 26). If needed, a user can visualize
all individually recorded data by moving the cursor on a line, right-clicking the mouse, and
selecting Mark Data Points option from the context sensitive pop-up, dropdown menu
(Figure 25). When this option is activated, single data points can be searched in the data
table by clicking on a specific value in the graph. Data points can now be edited or deleted
in the table (Power User only). When deselecting the option the individual data points
disappear again. Another option for showing the data is clicking on the respective ON-OFF
button in the toolbar line above the graph.

F-value (AIm K]

Show Data Points

K-Value

Temperature

2,5+

TTTT

2,04

| I I

sat15 Sat 22
Jan 2022 Time

Date / Time

14.01.2022 12.51:24
14.01.2022 13.51:24
14.01.2022 14:51:24
14.01.2022 15:51:24
14.01.2022 16:51:24
14.01.2022 17:51:24
14.01.2022 18:51:24
14.01.2022 19:51:24

14.01.2022 20:51:24
<

Figure 26 Temperature graph option
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4.3.4 WEIGHT GRAPH (DRYOUT MEASUREMENT ONLY)

Weight

Date / Time Net weight [g]

Gross weight Weight change
o] ]

14012022 1251:24 | 730.73 430,84 0,00
14.01.20221351:24 | 729.89 430,00 0,84
14.01.20221451:24 | 729.06 489.17 -1.67
14.01.20221551:24 | 728,32 48843 241
14.01.20221651:24 | 727.58 48769 315
14.01.20221751:24 | 726,84 486.95 -3.89
1401.202218:51:24 | 726,08 486,19 -4.65

sat15 Sat22

1401.20221951:24  |72531 48542 -5.42
Jan 2022 Time

14012022 2051:24 | 72461 4472 .12

Figure 27 Lower graph—Weight graph

The lower graph (Figure 27) is the weight graph. It shows a gray line that indicates the net
weight of the sample (i.e., the mass of dry soil plus the mass of water). The accuracy of

the absolute level of this data depends on the accuracy of the values for the setup parts
(needle sensor, soil sampling ring, o-rings, sampling ring lid), and possible additional weights
as described in the Information register tab. The relative accuracy of weight changes is
dependent on the accuracy of the scale used.

The x- and y-axes are automatically scaled to show all recorded data. Parts of the graph
can be manually enlarged and reset by right-clicking the mouse button and selecting the
Maximize option in the pop-up menu.

NOTE: Changing the time axis of the weight graph does not affect the conductivity graph and vice versa. Visualization of
the actual measured points can be activated and deactivated as described for the conductivity graph (Section 4.3.3).

Understanding the phases of evaporation are important for accurate interpretation of the
weight data. In a typical measurement the weight data will first show a continuous weight
loss at an almost constant rate that reflects the potential evaporation rate in the laboratory
environment. Small changes in slope can be caused by temperature fluctuations in a lab
and/or with the respective changes in relative humidity. The period of a constant weight
loss rate is called Phase 1 Evaporation and water loss during that phase is controlled by
atmospheric conditions (Figure 28). After Phase 1 evaporation, the rate drops and the slope
of the weight curve becomes less steep. This is called Phase 2 Evaporation (Figure 28). The
water loss rate is now controlled by the resistance of the drying soil near the soil surface.
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Figure 28 Phases of weight curve

4.3.5 CONDUCTIVITY DATA WINDOW

The window at the upper right (Figure 24) shows the recorded thermal conductivity data,
together with the times, the heating power, the temperature drift, the start temperature,
and the maximum temperature heat. The data can be edited by Power Users by hovering

the cursor in the data window and right-clicking the mouse. Possible operations include
deletion of lines, changes to contents, and displaying the heating curve of one consecutive
conductivity measurement (Figure 29). Also, multiple lines can be selected and the data can
be copied using the Ctrl + ¢ keyboard combination. In Power User Mode deletion of data will
immediately be shown in the graph on the left. By selecting one single measurement pointin
the graph, the table automatically switches to this measurement line.
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Figure 29 Heating curve

4.3.6 WEIGHT DATA WINDOW (DRYOUT MEASUREMENT ONLY)

The recorded weight data (Figure 27) is shown in the lower right of the weight data window.
After date and time (column 1) the measuring system total weight, including all tare weights,
is listed in column 2. The soil plus water net weight is calculated from the total weight minus
the tare weights as specified in the Information register tab and displayed in column 3.
These data are also depicted in the graph on the left side of the window. Finally, the net
weight change from the start of the experiment is listed in column 4.

Scroll through the data window using the righthand scroll bar. By moving the cursor into the
data window and right-clicking the mouse, the data can be directly edited by Power Users.
Possible edits include deleting and changing individual data cell content. Also, multiple lines
can be selected and the data can be copied (press the Ctrl + ¢ keys). Manipulation of data

or deletion of data (in Power User mode only) will immediately show in the graph on the left.
If one measurement pointin the graph is selected, the table automatically switches to the
corresponding measurement line.

4.4 EVALUATION REGISTER (DRYOUT MEASUREMENT ONLY)

This section describes how the Evaluation register tab (Figure 30) is used when calculating
thermal conductivity and water content data. The Evaluation register tab is used with dryout
measurement only.
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The Evaluation register shows three data groups in the upper part of the window that shows
the specifications for the absolute water contents calculation, calculated parameters, and
a menu where additional data points can be added. In the lower part of the window, a graph
shows the resulting thermal conductivity data . The graph shows the VWC versus thermal
conductivity (W/mK).

Right-click on the graph change the font size between small, medium, and large, and
maximize the graph. Also, the water content display can be changed between volumetric or
mass percent of water content.

B LABROS SoilView-Analysis - N\MGMFS0T\RedirectedFolders\Alina\Documents\LABRGS SoilView\Example_SAND Tvarios] - 503.0 - 0 X
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Figure 30 Evaluation register

4.4.1 ABSOLUTE WATER CONTENT EVALUATION

The relative shape of water content data is determined by the recorded weight change. The
absolute level of water content data is affected by the parameters specified in the parameter
group calculation of water contents.
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OPTION 1: INITIALWATER CONTENT CALCULATION FROM DRY SOIL WEIGHT

Calculation of water contents

(®) From dry seil weight [al:
(") From given intial water cortent [Val%]

() Estimation of initial water content

Figure 31 Water content calculation

The initial water content calculation from dry soil weight (Figure 31) is the best option if
the dry soil weight has been determined after the end of the measurement by oven-drying
at 105 °C for 24 h. The result accuracy depends on the precision of all involved parameters
that are specified in the Information register. From the data additional physical parameters
of the soil, such as the initial water content, the porosity, and the dry bulk density, are also
calculated and shown in the Calculated Parameters group.

NOTE: Only Option 1 leads to a 100% correct calculation of the absolute water content.

OPTION 2: USER-SET INITIAL WATER CONTENT EXTERNAL SETTING

Calculation of water contents
(") From dry soil weight [g];
(®) From given initial water content [Vol %]

() Estimation of initial water cortent

Figure 32 User-set water content calculation

The user-set initial water content external setting (Figure 32) allows a user to externally set
the initial water content to a specific value from wherever this value is determined.

OPTION 3: INITIALWATER CONTENT AUTOMATIC ESTIMATION

Caleulation of water contents

() From dry soil weight [a]:

() From given initial water cortent [Vl %]
(®) Estimation of initial water content

Figure 33 Initial water content estimation

If the soil dry weight is not available, option 3 can be used to automatically estimate the
initial water content measurement (Figure 33). The LABROS SoilView-analysis software
estimates water content assuming full saturation of the pore space (i.e., initial saturation =
100%). In practice this will rarely be reached; therefore, the calculated water content must
be seen as an approximation of the true water content. As a result of this assumption, the
initial water content, porosity, bulk density, and the dry soil weight can be calculated. These
values are shown in the Calculated Parameters group.
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If the mode of the initial water content is changed, the user-edited values for the dry soil
weight and for initial water content remain in storage. This allows the user to switch between
the options and to compare the outcomes of the different calculation options without losing
the inserted information. Be aware that the calculation is always based on the chosen
option. For these reasons Option 3 is not usually recommended.

IMPORTANT: The calculation of porosity and absolute water content depends on all specified parameters in the
Information register being correct. Any error in the data of the dry bulk density (default = 2.65 g/cm?), the mass of

the sampling ring containing the sample, and mass of dry soil specified in the Evaluation register will be linearly
transferred to the results.

IMPORTANT: Overfilling or underfilling the sampling rings with soil will cause appreciable errors. As a general
guideline,a 1-mm error in sample weight causes an approximate 2% error in the calculated data.

4.4.2 ADDING INDEPENDENT CONDUCTIVITY DATA

Add WLF data points

!
K :iﬁ:_d Weighting

W AmE)] Vol %] factaor

Figure 34 Add independent conductivity data

Users can add independently measured data from the METER TEMPOS and other devices
measuring thermal conductivity (Figure 34).

Right-click the blank editing field and select one of the option in the pop-up menu that
appears (Figure 35):

Insert row

Delete row

Delete content

Figure 35 Pop-up menu

The data points entered from independently measured data are displayed as filled dots in
the graph, and data measured by the VARIOS are shown as empty circles.
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Carefully select the appropriate units when adding data:
» thermal conductivity must be added in W/mK units

* VWC must be added as a percentage.

NOTE: Make sure to use the correct regional conventions for the decimal separator (comma or period). Added data
can be edited and deleted.

4.5 FITTING REGISTER (DRYOUT MEASUREMENT ONLY)

This section describes how the Fitting register tab fits thermal conductivity functions to the
data. The Fitting register tab is used with dryout measurement only. Model selection and
function parameters are available in the Fitting register tab (Figure 36).
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Figure 36 Fitting register

For use in numerical modeling, thermal characteristics are described by parametric
functions for A (0) and C (8), where 6 (m*m?) is the VWC, A (W m™' K') the thermal conductivity,
and C (J m= K™ the thermal capacity. LABROS SoilView-Analysis software provides a
high-class algorithm to fit a variety of functional relationships of the (6) curve to the data
(Cis the sum of the head capacities of the mineral, the organic, and the liquid phases).

No specification of initial guesses for the parameter values is required. Six widely-used
conductivity models are available. All models are described in Appendix A.

31



4.5.1 FITTING FUNCTIONS

The Fitting register tab has the Curve Fitting button (Figure 36), as well as the Optimization
Parameters button on the left (allows user to edit the optimization parameters), and the
Restore Parameters button on the right. The data to be fitted is shown together with the
fitting function in the graph in the lower part of the window. The Restore Parameters button
will reset all values for the parameter bounds to the default values.

To fit the selected function to the data left-click on the Curve Fitting button. A window will
pop up (Figure 37) that indicates that the fitting routine is running. This process will last only
a few seconds and cannot be stopped or otherwise interrupted.

NOTE: In some cases the fitting process will work continuously and not lead to completion. In these cases the user can
cancel the process in the Windows Task Manager.

Fitting...

Evaluation is camied out. This process can last some minutes
and can not be cancelled.

— —= /

Figure 37 Fitting process window

The fitting algorithm minimizes the sum of squares deviations between data points and
fitted functions using a global optimization scheme.

4.5.2 SELECTING A FITTING MODEL AND PARAMETER BOUNDS

Afitting model is selected by left-clicking in the radio button next to the desired fitting
model on the Fitting register window. By default all model parameters are included in the
fitting process (except parameter ths for model LU 2007 and Cote and Konrad; Appendix A)
and are allowed to vary within a predefined range. The ranges of values are wide enough to
cover physically consistent parameter combinations. A user can alter the permissible values
of the bandwidth by changing the default minimum and maximum value. For most soils this
will not be necessary. In some cases users may have prior knowledge about parameters

that can lead to greatly reduced bandwidths and changing the parameters based on prior
knowledge will speed up the convergence of the algorithm.

To change the default minimum and maximum parameter values type the new value into
the respective field in the group Thermal Conductivity function parameters. To store a
typed value the cursor must be moved out of the field either by pressing the Tab or Return
key or by moving the mouse to another field. Default values can be restored by selecting
the Restore Parameters button.
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If the checkbox in front of the parameter is selected, the value will be automatically
calculated. By unchecking the checkbox the default value shown can be overwritten with a
new value entered manually. If a model selection is changed, the user will be prompted to
confirm whether they want to continue with the new value for the fitting parameter or not.

4.5.3 FITTING PARAMETER ESTIMATION AND UNCERTAINTY MEASURES

After the fitting process is complete, the parameter fields switch from the Input mode

to the Results mode (Figure 38). In Results mode the optimized parameters are shown in
the previously empty column with the Value fields and the uncertainties of the individual
parameters indicated by 95% confidence limits for the parameter values (expressed by the
2.5% quantiles and the 97.5% quantiles in the following two columns). The mathematical
background for the calculations of uncertainties is provided in Appendix C. For fixed
parameters the uncertainty is zero.

B LABROS SoilView-Analysis - [\\MGMFS0T\RedirectedFolders\Alina\Dacuments\LABROS SoilView\Example SAND_2.varios] - 5.0.3.0 - o X%
File  Extra (HYPROP only)  Help www.metergroup.com
IO, ® @ ®
Showfileexplorer | Open  Save Saveas UserSurvey Feedback | Seftings | Manual |
i Irformation o Measurements E Evaluation Fitting a Export
Themal conductivity mode! selection “Themal Conductivity function parameters Statistical analysis
o BEEE original A Parmeter Voue 25%  §75% | Unt rsa s 00375
Matrix Campbell @ A 181|173 183 E 03968
AC 157300
Parameter L 014 c 8 319 31 33 Ao 157274
O, Uncertairties LU 2007 c C 5084 4945 (5222 |-
Cote and Konrad C D 053 |05 |057
Optimization =|e 159|149 [168
ﬂﬂﬂ Pl Luand Dong c .,
Model: Campbell Model Code: 10 ?

Source: Campbell (1985)
Description: A@)=A+B8+A-Djexp(ICE] E )

Thermal Conductivity | || Show data as dots

function data @ added data

restore parameter

Thermal Conductivity [W/(m*K)]

Thermal Conductivity [Wim K)]

25 30 3B 40

20
wol. water content [%]

Powerlser -

Figure 38 Fitting register Results mode
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The quality of the fit is quantified in the group Statistical analysis in the upper right and
can be visually inspected from the graph. Fit quality is given in terms of the root mean
square error (RMSE). The RMSE is an indication of the mean distance between a data point
and the fitted function. An RMSE of 0.01 for the thermal conductivity data fit indicates

an average distance of the fitted curve to observed data of W m~ K™'. Additionally, the
coefficient of determination (r?) and the Nash-Sutcliffe Index (E) are displayed. Models
with a higher number of parameters are generally more flexible, and the fitting error will
become smaller for models with a larger number of parameters. This is counterbalanced
by a higher correlation between the optimized parameters and higher uncertainties for the
individual parameters.

As an aid in deciding which model is most appropriate, LABROS SoilView-Analysis software
shows the corrected Akaike Information Criterion (AICc, Akaike, 1974; Hurvich, Tsai, 1989) in
the Statistical analysis group. This criterion accounts for the different number of adjustable
parameters when selecting the best model. The value will normally be negative. The more
appropriate model is one with the smallest value (i.e., the larger the absolute number).

NOTE: The actual value of the AICc has no meaning. It can only be used to compare different fitting models for one set
of data. For details on the statistical criteria see Appendix C.

As indicated above, models with a higher number of parameters are generally more flexible
but they will have a higher correlation between the optimized parameters and higher
uncertainties for the individual parameters. Pressing the Parameter Correlation Matrix
button will cause the parameter Correlation Matrix window to appear (Figure 39).

Idry lsat thf m
by 0.000 0.000 0,000
st |1.000 1,000 0.000 0.000
itf 0.764 0.783 1,000 0.000
m 057 0384 0878 1,000

Figure 39 Correlation matrix window

In this symmetric matrix the linear correlation coefficients of the parameters are listed.
Negative values indicate that the increase of one parameter value can be (partly) balanced
by a decrease of the another parameter; positive values mean that an increase of either
parameter value has a similar effect on the overall fit of the functions. Generally, correlation
coefficients with absolute values smaller than 0.95 indicate a quality fitting problem. A
parameter correlation that is too high indicates an overparameterization of the selected
model and is undesirable.
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4.5.4 FUNCTION GRAPHS

In the lower part of the Fitting register window a graph appears containing the calculated
VARIOS data, the entered data, and the fitted conductivity function. As with any other graphs
in the LABROS SoilView-Analysis software, the graph can be magnified to full screen or
zoomed in by selecting the respective option in the context-sensitive submenu. Right-click
the mouse to access zoom or full screen viewing for the graphs.

The fitted functions will disappear from the screen if either parameter settings are changed
(e.g., by modifying the permissible data range), or if a setting in another register is changed
that affects the calculated VARIOS data. After the fitting process, the fitting results can be
exported as explained in the Export register (Section 4.6).

4.5.5 MODIFYING OPTIMIZATION PARAMETERS

Edit Parameters... n
v Control parameters for multiobjective estimation
NUMBER_TCFUNC 10
theta_max 0.4
theta_min 0

NUMBER_TCFUNC
Mumber of supporting data points to depict the themmal conductivity functions
(default = 101).

Default Use it for the session Cancel

Figure 40 Edit Fitting parameters

Users can edit some of the parameters (Figure 40) that specify the calculations and the
depiction of the fitted function. The specifications are listed by selecting the Optimization
Parameters button and are described in Table 10.

35



Table 10 Fitting parameters options

Editable
Data Public Power
Variable Explanation Value User User
NUMBER TCFUNC Number.o!c points for the displayed and exported 101 Yes Yes
- conductivity function.
Upper limit of water content range to calculate thermal 0.6 Yes Yes
theta_max conductivity functions (default: maximum measured
water content).
Lower limit of water content range to calculate thermal 0 Yes Yes

theta_min conductivity functions (default 0)

4.6 EXPORT REGISTERS

The Export register tab (Figure 41) enables all graphs, raw data, calculated data, fitted
functions, and other parameters of interest to be exported. User specifications for data
format, file name convention, and directory will be kept as default as long as the user
remains in the session.

LABROS SoilView-Analysis supports the Microsoft Excel® output file format (*.xs1x). The
Excel file will contain all relevant data in different worksheets:

» Configuration and information

» Measured data

« Evaluation of measured conductivity data (dryout measurement only)
« Fitted conductivity data (dryout measurement only)

« Parameters of fitted models (dryout measurement only)

« Correlation matrix of fitted data (dryout measurement only)

« Statistical analysis (dryout measurement only)

« Measured raw data (if specified)
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= LABROS SoilView-Analysis - [\\MGMFSD1\RedirectedFolders\Alina\Documents\LABROS SoilView\Example_SILT.varios] - 5.0.3.0
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Contert
Charts Data
‘Themal Conductiviy Information
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K Weight Spline Points
Resuts
[ Raw data

Post-Processing.
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History

PublicUser -

Figure 41 Export register

4.6.1 OUTPUT SETTINGS

Different output settings are available and described below. To export, left-click on the
Export button.

File Maming...

Filename format: |cDate >_«<Samplename> | |:-;st w
<Samplename:: <Date>

Directory: |C:\Users\Nina\Desldop‘\ | Browse...

Figure 42 Export data filename

Enter the output filename in the Filename format field (Figure 42). All permitted characters
can be used in the filename. The two default settings <Date> and <Sample name> are available

for optional use in any position within the filename. They will automatically be replaced by
the current date or sample name.
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REGISTERS FOR PROCESSING DATA

Directary: C:\Users Alina\Desktop®. Browse...

Figure 43 Directory

Enter the output directory in the Directory field (Figure 43) or click on the Browse button to
select a directory.

4.6.2 CONTENT

In the Content window (Figure 44) select the checkboxes for the charts and the data that
should be exported.

NOTE: Exporting raw data is deselected by default. When exporting the raw data, select the Raw data checkbox.

Content ...
Charts Data
Themal Conductivity Infarmation
K-Value Measured values
K Weight Spline Points
Results
[] Raw data

Figure 44 Content window checkboxes

4.6.3 POSTPROCESSING

In the Postprocessing group set different actions that should be executed either after
exporting or while exporting (Figure 45).

Do nothing W

Show in Explorer
Open main exported file
(a0 to Export Folder Mow

Figure 45 Postprocessing
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4.6.4 HISTORY

The History group (Figure 46) provides an overview of all recently executed exports.

Histany

C:hvUsers'\Alina‘\Desktop \220505_025_G4_11_55 20220221_1240_ThemalConductivity png created
CAUsers‘\Alina“Desktop 220505 _025_G4_11_59 20220221_1240_KValue png created
C:iUsers'\Alina“\Desktop 220505_025_G4_11_55 20220221_1240_KWeight png created

Figure 46 History group
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SERVICE

5. SERVICE

5.1 CUSTOMER SUPPORT
NORTH AMERICA

Customer service representatives are available for questions, problems, or feedback Monday
through Friday, 7:00 am to 5:00 pm Pacific time.

Email: support.environment@metergroup.com
sales.environment@metergroup.com

Phone: +1.509.332.5600
Fax: +1.509.332.5158

Website: metergroup.com

EUROPE

Customer service representatives are available for questions, problems, or feedback Monday
through Friday, 8:00 to 17:00 Central European time.

Email: support.europe@metergroup.com
sales.europe@metergroup.com

Phone: +49891266520
Fax: +4989 126652 20

Website: metergroup.com

If contacting METER by email please include the following information:

Name Email address
Address Instrument serial number
Phone Description of the problem

NOTE: For products purchased through a distributor please contact the distributor directly for assistance.

5.2 TERMS AND CONDITIONS

By using METER instruments and documentation, you agree to abide by the METER Group,
Inc. Terms and Conditions. Please refer to https:/meter.ly/terms-conditions for details.
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APPENDIXA. THERMAL CONDUCTIVITY THEORY

This appendix contains an overview of thermal conductivity theory, functions, and thermal
conductivity courses.

Thermal conductivity of porous media, such as soils, depends on mineralogy, organic matter
content, bulk density, and water content. The water content is highly variable within short
time intervals (days to months), whereas the other variables can be regarded as constant.
Therefore, typical models for thermal conductivity describe the relationship between
thermal conductivity A (W m~" K™) and VWC 6 (m3/m3).

There are two ways to derive the values of the model parameters:

« Predicting values by means of known soil properties (on mineralogy, organic matter
content, bulk density).

» Using measured data for A(0) and estimating the parameters by nonlinear regression.

The LABROS SoilView-Analysis software applies the latter approach.

In order to empirically describe the A(0) relation, Johansen (1975) introduced a normalized
thermal conductivity function, called Kersten number: K, = (A(6)-A,,,)/(\,,~\,,), where X, and
), are thermal conductivities at oven dryness or saturation, respectively. The dimensionless
K, (L) relation was described by a simple logarithmic function. This model type was adopted
by several authors with different descriptions of K,(A) (Cote and Konrad, 2005; Lu et al., 2007;
Lu and Dong, 2015). The general form of this function type is:

;‘(8) = ldr}. + Ke Oksat _}Ldry) Equation 1

Figure A.1 shows the course of these kinds of functions for the Lu et al., (2007) (left) and Cote
and Konrad (2005) (right) formulations (details of the models are given in Appendix B).
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Figure A.1 Thermal conductivity courses for Lu et al., and Cote and Konrad

Figure A.1 shows typical courses of the Lu et al. (2007) (left) and Cote and Konrad (2005)
(right) thermal conductivity models using the Johansen (1975) approach. The parameter
varied for the Lu et al. (2007) model was o (0.5 0.9 1.1). The parameter varied for the Cote and
Konrad (2005) model was k (0.2 1.0 5.0).

Besides these Johansen type functions there are some other models, such as the predictive
model of Campbell (1985) and the empirical model of Chung and Horton (1987), which are

both implemented in the HYDRUS-1D and HYDRUS 2/3-D software packages (Simunek et al.
(2013) and Simunek et al. (2006)). All models implemented in the LABROS SoilView-Analysis
software are listed in Appendix B. The model of Campbell (1985) is particularly well suited to
describe thermal conductivity functions for sands because of its flexibility and general shape.

Figure A.2 shows the courses of the Campbell model for typical soils (details of the models
are given in Appendix B).
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Thermal Conductivity [W m~" K]
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Figure A.2 Thermal conductivity courses for Campbell

Figure A.2: Typical courses of the Campbell (1985) thermal conductivity model for three
different textures. Parameters for A, B, C, D, and E are: 1.5, 1.7, 15.0, 0.25, and 4.0 for the sand,
1.0,1.4,8.0,0.2,and 4.0 for the loam and 0.4, 1.1, 7.0, 0.15, and 4.0 for the clay, respectively.
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APPENDIX B. FREQUENTLY USED MODEL TYPES

This section provides and explains nine different model types that are frequently used.

Johansen (1975)

AB) =2, + O, — A, [AIn(S) + B]

Equation 2

with &, (W m™ K1), A (W m™ K™), A(-) and B(-) as fitting parameters and S(-) is saturation
defined as 0 divided by 6, where 6,(-) is the saturated water content. In order to guarantee
that A=2, at saturation, B should be set to unity. Since in(S) becomes very negative at

low values for S, the Johansen model is meaningless close to oven dryness. The model is
currently implemented in a way that if A<}, A becomes

dry*

Lu et al. (2007)

a-1.33
AO) =2, + (A, — 2, Jexp (e[l — $*7]) Equation 3

with &, (Wm™ K7), & (Wm™ K™), and o(-) as fitting parameters and S(-) is saturation defined
as 0 divided by 6, where 6 (-) is the saturated water content.

Cote and Konran (2005)

K5
A(B) = ldw + {lm - ?‘dry) 14+{k—1)8 Equation 4

with &, (Wm™ K7), & (Wm™ K), and k() as fitting parameters and $(-) is saturation defined
as 0 divided by 6, where 6 (-) is the saturated water content.

Lu and Dong (2015)

8\ m| w1l
= d sat | dr - ;]
AO) =1, + O, 2 y){1 [1 + (op) ] }

Equation 5

with &, (Wm™ K7), & (W m™ K'), m(-), and 8(-) as fitting parameters.

sat

He et al. (2017)

B-B1 -1
= -2 A
A(8) ?de + {lsut dry)[ ¢ ] Equation 6

with &, (Wm™ K1), 0 (Wm™ K), A(-), and B(-) as fitting parameters.
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Campbell (1985)

A(6) = A+ B6 — (A — D)exp (—[C8]%)

Equation 7

with AWm™ K), BW m™" K'), C(=),D(W m™" K~'), and E(-) as fitting parameters. These
parameters can also be derived from soil properties and mineralogy. As can be easily seen,
D=}, thermal conductivity at 6=0. The model of Campbell is very flexible and can be used to
describe almost every data set as long as the A(6) is monotonously increasing. Parameter E is
usually fixed at 4.0.

Lu et al. (2014)

A(0) = Adry + exp( — 6) Equation®

with &, (W m™ K'), b and d as fitting parameters.

Chung and Horton (1987)

2
A() =2, +b0+b0

Equation 9

with A, (W m™ K™), b,(W m™ K™, and b3 (W m™' K™') as fitting parameters.

dry
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APPENDIX C. PARAMETER ESTIMATION

The following explains and defines the objective function for parameter estimation.

The parametric models for A(0) are fitted to the data points. The fitting is accomplished
by a nonlinear regression algorithm by minimizing the sum of weighted squared residuals
between model prediction and data pairs:

o®) = L w, [T -1w)]
i=1 ML ' Equation 10

where r is the number of data pairs of A(0), W;,;are the weights of the individual data points,
in case of fitting only one data type often set to unity, and %, and A,(b) are the measured and
model predicted values, respectively, and b is the parameter vector.

The parameter estimation procedure must guarantee that the best parameter combination
for the appropriate model is found, (i.e., the global minimum in the multidimensional
parameter space must be determined). Often local estimation algorithms such as the
Levenberg-Marquardt algorithm (Marquardt, 1963) are used for parameter estimation.
However, especially for complex models with many degrees of freedom, these algorithms
depend on the initial guesses. Therefore, the software uses the shuffled complex evolution
algorithm (SCE) (Duan et al., 1992), which is a global parameter estimation algorithm.
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APPENDIXD. POSTPROCESSING DIAGNOSTIC VARIABLES

The first measure to evaluate the performance of the fitted model is the objective function
values at their estimated minimum, @,,,.. This is the weighted sum of squared residuals.

min*

A more descriptive measure, giving the mean deviation between model and data is the root
mean square error, RMSE:

1w -] 2

RMSE =+ [—X|V -V
i=1 ! : Equation 11
where y, and §, are measured and model predicted quantities, i.e., thermal conductivities. For

a sound representation of the data by the model, the values of RMSE should be close to the
measurement error.

The Nash-Sutcliffe index (Nash and Sutcliffe, 1970) and coefficient of determination are also
calculated. The Nash-Sutcliffe index is given by Equation 12:

ZZJ[y i_’:] ’

E=1-+
le[yi—;i] ’

Equation 12

where 7, is the mean measured quantity. In Equation 13 the coefficient of determination (r?)
is given by:

Ezz[yi_;i] [;:_;'_:

T —Jz2[~ F:
E[y[.—y,] yi—y{] .
1 Equation 13

To account for the different number of adjustable parameters when comparing different
models fitted to the same data, LABROS SoilView-Analysis software also calculates the
Akaike Information Criterion, AIC = 2(L+k) (Akaike, 1974), where L is the likelihood function
and k is the number of fitting parameters. In a least squares estimation and with N(0,6?)
distributed residuals the information criterion, AIC, can be expressed in the form as
described by Ye et al. (2008):

r2=1—

AIC = nin(®  /n)+ 2k

Equation 14

where n is the number of measured data and k is the number of adjustable parameters. If the
number of measurements, n, is small in comparison to k, the original form of AIC should be
extended by a correction term that accounts for small values for n/k (Hurvich and Tsai, 1989),
leading to the extended information criterion:
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2ke(k+1)
n—k—1 Equation 15

AlCc = nin(®__ /n)+ 2k +
min
where nin(®,,/n) penalizes a poor fit, 2k is the number of parameters, and 2k(k+1)/n-k-1 is the
correction for small values of n/k. If n/k becomes large the [super fraction] becomes negligible
and the AICc converges to AIC.

Since sometimes other information criteria are suggested as well, LABROS SoilView-Analysis
calculates also the BIC and KIC for model selection. These two are given for least square
estimations as follows (Ye et al., 2008):

BIC = nin(®__ /n)+ kin(n)

Equation 16
and
T
KIC=(n - knl® [n|— kin(2n)+ In|]J] W
( ) ( mm/) ( ) l/ | Equation 17

Where [J/TwJ] is the determinant of the Fisher information matrix. J is the Jacobian or
sensitivity matrix with elements J,.J:cfi/a\bj where Z is the model prediction at point i and b,
is the j—th parameter. The superscript T indicates the transpose of the matrix and w is the
weighting matrix.
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APPENDIX E. UNCERTAINTY ANALYSIS

E.1 PARAMETER UNCERTAINTIES

In order to evaluate the uncertainties of the estimated parameters a linear
approximation of the covariance matrix of the estimated parameters, C, is calculated
(Omlin and Reichert, 1999):

Qi T -1
P min

C ~-"(1 wj)

P Equation 18

The linear approximation leads to a confidence interval for the i estimated parameter 15\ by:

b: + Cpi,i X tn—k,afz

Equation 19
where, ., is the upper o/2 quantile of the r-distribution with n—k degrees of freedom. a. is
set to 0.05 leading to the 95% confidence interval for the parameters.

E.2 FUNCTION UNCERTAINTIES

The uncertainties for the A(0) functions are determined by calculating the covariance of the
model response, C.:

T
c,~JCj
z Equation 20
where the J is the Jacobian or sensitivity matrix with elements JI.J:aZ./ab, where Z, is the
model prediction at pointi and b, is the jth parameter. The confidence interval for the model
output is given by:

vt \/CZi,i X th—_ka/2

Equation 21

where ¥, is the model output X,.. Again, is set to 0.05 leading to the 95% confidence intervals
for the functional relationships.
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